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1. For this layout, I used a couple of the new panels in the Saratoga Collection (www.goldenstudios.com).
I designed it in Gerber Omega and exported the parts as Adobe Illustrator. I imported them into a Photoshop document
and added some color on the two panels.The background layer was filled with a beige gray color that approximated 
the front of the building. I cropped my design to the edges of the panels.

Put your sign on 
their building with Photoshop
Giving the customer a preview of their sign can be a powerful sales tool

By Mike Jackson

Mike Jackson

ome sign shops take an extra step in 
the design and sales process to make 
a photographic mock-up of the client’s

sign—showing the sign design as it would
appear on the building or vehicle. As I write

S
this, the first thing that comes to mind is
whether this step is necessary to make the
sale. Is it simply wasting time that is either
paid for by the client or is absorbed into 
the monthly overhead? Can you make the

2. This screen capture shows how I layered this design 
to make it easy to transfer later. Keeping the design layers separated
from the background helped here, but wasn’t essential to the process.
This image will be needed later in the process.When I was ready,
I turned off the eye icon on the background layer and did a Copy
Merged from the Edit menu.

3. This image shows the front
of the studio where I might want to place
a sign. I set up a tripod in the driveway
and got ready to take two shots. I knew
the sign would be six feet long, so I found
the center of the garage and put down 
a piece of duct tape on the top trim, then
moved over and put another piece of
tape three feet on either side of that. I
took one photograph with the tape.Then
I removed the tape and shot it one more
time without moving the tripod between
shots. In Photoshop, I opened the one
without the tape first, opened the one
with the tape, copied (Control-C) it to 
the clipboard and pasted (Control-V) 
it on top of the first one.The pasted
image will be imported as a new layer
automatically.

4. In my case, the two images were almost identical 
so I didn’t have to do any adjustments. For someone taking the two
photos without a tripod, one method is to change the layer mode from
Normal to Difference.Then select the Move tool and use the arrow keys
to nudge the top layer around to match as well as possible. Newer 
versions of Photoshop have a command called Auto-Align Layers under
the Edit pull down menu. Shift-Select the two layers in the layers tab 
and use the command.
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same sale without taking this extra step 
and spending the time? 

Okay, let’s assume the job justifies the
effort. Now what?

Essentially, there are three steps. Step one:
Prepare a sign layout in which the design is 
on a transparent layer. Step two: Take photos
of the building, vehicle or subject, including
some size reference photos. Step three: In
Photoshop, combine all the parts and resize
the image to fit the appropriate area on the
building or vehicle.

Prepare the layout In most cases, the sign
size is already established during the initial
sales step.

Whether designing in a dedicated sign mak-
ing program like Gerber Omega, Signlab, or
CasMate, or a commercial desktop publishing
program like Photoshop, Illustrator, Corel
Draw, or even a scan of a design, the goal is 
to get a bitmapped image ready to work with-
in a program like Adobe Photoshop. Vector-
based programs will usually have bitmap
export options. TIF and JPG work fine for this
process since they work in Photoshop.

When possible, I design the final image 
in a program that supports “layers” or trans-
parent backgrounds. That saves a step or two.
If that is not possible, it will be necessary 
to knock out, or delete, the background in
Photoshop. Either way, the goal is to end up
with a sign layout or panel on a transparent
layer so it can be placed and resized over 
the building or vehicle image as a layer 
in the later steps.

Photoshop is a bitmapped (raster) based
program. Many design and layout programs
are “vector” based, but most of them will
export bitmapped file formats compatible
with Photoshop.

While not absolutely necessary, it is a good
idea to design the image with a background
similar to the actual wall, building or vehicle.
When the background is deleted in later steps,
there will often be remnant “fringe” resulting
from the anti-aliasing in the original image.
For example, if the sign layout is designed 
on a white background, when the background
is deleted, there will be various values of gray
pixels along the edge. If placed on a dark brick
or wood building, the gray pixels could show.
If designed on a dark brown background few,
if any, edges will be seen when composited
over the background image.

There may be some scale issues to consider,
too. In most cases, the final comp will only
need to be printed on an image that’s only 
8-by-10-in. or so. The original vector file might
have been designed for a 4-by-8-ft. sign, and 
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if exporting that size at 300 dpi, the file size
could be huge. To save file size and be more
efficient, scale a copy of the original layout
down to 10-in. or so wide, then export it in 
or TIFF file format [go to Image>Image Size].
Normally, I work all of my photos and images
at 300 dpi at the size I will be printing.

Remove the background If you’re working on
a layered design in Photoshop, with the back-
ground on a separate layer, you can just sit
back, as quite a bit of the work is done. I’ll
explain how to move the active layers in the
last steps of this article.

If the design is on a single layer with a solid
background, it is necessary to remove the
background. By default, Photoshop will not
allow transparent pixels on the background
layer, but changing to a normal layer is as
easy as either renaming the layer to some-
thing else, or dragging the little lock icon to
the trash can. Doing so will change the name
to Layer 0.

Now, Click the Magic Wand tool in the toolbar
and check the Tolerance settings at the top 
of the menu bar. Set it to around 32, then click
on an area in the background. “Marching ants”
should appear indicating selected areas. Hit
the Delete key on the keyboard and the back-
ground should disappear. In those areas,
a gray checkerboard pattern should appear—

indicating transparent pixels.
If there are additional areas that need to 

be deleted, simply click on them again with
the Magic Wand tool and delete them.
(Alternatively, advanced users can create 
a layer mask to hide the background and 
also take advantage of the “refine mask”
features in later versions of Photoshop.)

When finished, there should be only the
sign layout on a transparent background.
This is always a good place to save the 
current image as a new file name in either 
TIF or PSD formats. This finished file will 
be needed again in later steps.

Take photos in the field Just about everyone
has some sort of digital camera now, so get-
ting a digital image is fairly straightforward.
Most people will probably shoot their photos
in JPG format. Tripods are a great tool for a
project like this, but not absolutely necessary.

This step takes a little planning and possi-
bly a couple of extra ingredients, though. You
will need references for size and location later
in the process. Every job is different, but I’ll
throw out a few scenarios. A simple solution
is to take a lightweight sheet of material the
same size as the final sign and hold it up
approximately where it will go. Corrugated
plastic would work in most cases. Or, if you
can get to the side of the building, you could

5. Digital cameras capture images at different sizes
based on their mega pixel count. In most cases, the resolution will be
much larger than you might need for a final image for a permit or for 
a portfolio photo. Resizing the image at this stage can save unneces-
sary file size. Under the Image pull down, select Image Size and make
the necessary adjustments. For this project, I chose 8-in. tall and left it
to resize proportionally at 300 dpi.This command will resize both lay-
ers at the same time.To keep track of the layers, I double-clicked on 
the default name in the layers tab to change the layer’s name.

6. At this stage, the project has a background layer with no 
reference points and another one with the markers aligned over it.
Open the “design” image file again.With the background layer turned
off, copy the contents of the layer with the design on a transparent
background. In my case, I had two layers in my design image so 
I selected both layers, then used Copy Merged instead of just “Copy”.
After switching back to the image with the two background images,
I pasted the contents from the clipboard using Control-V.The pasted
image is typically pasted somewhere in the middle of the image,
but will usually need to be resized and repositioned.
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7. To help me with the resizing, I clicked in the Rulers
on the left side (View>Rulers or Control-R if they are not visible) and
dragged a vertical guideline to the edge of the left piece of tape.
I repeated it for the right tape mark.

8. Since the sign design was on a transparent layer (after it was pasted in an earlier step), all I had to do 
was use the keyboard shortcut Control-T (Command-T on the Mac) to get the Resize Image tools. I clicked somewhere 
in the middle of the design and repositioned the image so one side was against a guideline.To maintain proportions,
I held down the Alt key (Option key on the Mac) and dragged one of the opposite corner handles to resize it to touch 
the other guideline.To accept the resizing, I hit Enter.

locate markers with masking tape or duct
tape, take the photos and remove them.

But it isn’t absolutely necessary to place 
the reference points exactly where the sign
will go—you just need some sort of size refer-
ence. For example, if the sign is going to be 
4-by-8-ft. and will go on the second story,
you only need to photograph something 
8 feet long in front of the building. Later,
you will be resizing your layout to the length 
of the reference points.

In most cases, take one shot for size 
reference, then remove the markers and pho-
tograph it again without moving the camera’s
distance from the subject. The tripod setup
helps here. If you take the photos without 
a helper, use the tripod and the 10-second
timer.

For a truck or vehicle, you can simply add 
a few reference marks using a Stabilo pencil.
After the reference shots, wipe them off with
a damp rag. Again, if you do a little planning,
getting appropriate reference marks is easy.

Oh, yes—one minor point: For the final
composition to be effective and convincing,
consider the direction of light in both the 
field shots and the design. If the design file
has bevels and shadows, plan the trip to the
field so the light and shadows are similar.
Conversely, if you shoot the field shots first,
apply the bevels and shadows in the design
image to match those of the field images.

Combine the location shots Photoshop typi-
cally offers a variety of different ways to get
the same end. You may find your own work-

flow for these steps, but in the end, most 
will be fairly similar.

While it might be possible to combine all
the parts in a single Photoshop layer, using 
its layering features can save a lot of time 
and give you much more control. Here I can
only offer the basics of using the Layers, but
learning them is essential to efficient use 
of the program.

For most projects, I’d suggest opening the
unblemished background image from the
location shoot. It will default with that layer
titled Background. If the Layers window is not
visible, click the Window pull-down menu and
pick Layers or hit F7 to toggle it on or off. To
the left of the background layer, you will see
an “eye” icon. The background layer should 
be highlighted to indicate it is active and 
the eye should be visible.

Open the second photo—the one with 
the tape marks or reference size elements—
in a new document. Now, we must move this
image into a layer above the background 
layer in the first file.

It is possible to click-and-drag the layer
from one image to another, but here’s how 
I do it. I hit Control-A in the reference image 
to select all of it (Command-A for Mac), the
Control-C (Command-C) to copy that informa-
tion to the clipboard. Normally, I close that 
file at that point.

Then go to the background image and hit
Control-A to select all of it, and Control-V to
paste the information into the document as 
a new layer. The new layer will be highlighted
with the eye turned on. The underlying back-
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ground layer will be gray. Click the eye icon 
to turn it off and see the background layer,
then back on to see the tape, panels or refer-
ence marks layer.

If the two images were shot with a tripod,
they should be very close in alignment. If not,
one trick is to change the layer mode (at the
top of the Layers tab) to Difference using the
pull-down menu. Click V, or click the Move tool
and use the keyboard’s up/down, left/right
arrow keys to nudge the top layer until the
two layers match up as well as possible.
Remember, this doesn’t have to be dead-on.
It is just a reference layer. Once you have it
somewhat aligned, change the layer mode
back to Normal.

Add the sign to the photo Now we can place
the design created earlier, on top of the back-
ground image and reference image file. Open
the design image file.

If you are an experienced Photoshop user,
just drag the new layer from the current
image to the background document. I typically
use the same technique described earlier to
get the second background image on top of
the original background. Click Control-A to
select all and Control-C to copy it to the clip-
board. Change to the background document
and press Control-V to paste it into a new
layer.

Resize and position the design The last
step in the process is to resize and relocate
the sign design over the background layer(s).
Click the image thumbnail in the Layers list.
Once selected, click Control-T to activate the

11. Normally, I save the final file as layered PSD or TIF file in case I need to reposition or edit the 
image, then save a copy with a different name. Since it wouldn’t need to be layered, I flatten the image by going 
to Layers>Flatten Image (or F10), and saved it.This particular image was optimized for an 8-in. tall print. It was saved
originally at 8x12, so I’d need to crop it to 8x10 if I wanted to print it at the size.

9. To hide the layer with the tape markers and step ladder,
I clicked the Eye icon on the layer.To get rid of the guidelines,
there were two options. Either go to the View pull down and click 
the Clear Guidelines option, or click on Show and uncheck Guides
(or use Control-semicolon / Command-semicolon) 

10. While the design was still layered, I clicked the layer with
the sign design to make sure it was the active layer then clicked the 
FX button at the bottom of the layers list. From that menu, I picked
Drop Shadow and made a few adjustments to the shadow and 
clicked Okay.
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Mike and Darla Jackson operate Golden Era
Studios in Jackson,Wyoming, and do 
a variety of sign-related projects. Mike’s Web 
site is www.goldenstudios.com. His e-mail
address is golden@goldenstudios.com.
You can see more of Mike’s photos at:

www.mikejacksonphotography.com and www.goldenstudios.com.

resize tools on the selection. To constrain 
the properties of the design, hold down the 
Alt or (Option) key and drag a corner down 
so the sign design fits the area on the top
Letters background layer. As a rule of thumb 
in a bitmap editing program, you can easily
resize down and maintain image quality. If
you resize larger, though, you will begin to
lose quality.

Use the arrow nudge keys to reposition the
layout as needed. When everything is resized
and repositioned, hit the Enter key on the key-
board. Depending on the type of sign, you
might also consider adding a shadow to the
image based on the global light sources. I’d
use the FX option at the bottom of the layers
list and choose Drop Shadow. (See Getting the
most out of the Photoshop’s FX Tools in Photoshop
in the May/June 2011 issue of SignCraft.) Once
the design layer is set, click the eye icon on
the layer that has the placement/reference
marks to turn its visibility off.

Typically, I’d save the entire document as
either a TIFF or a PSD at this point. Both are
capable of maintaining the layers if needed in
the future. Both formats will print to a stan-
dard printer while still layered. If desired, the
entire document can be “flattened” by going to
the Layers pull down and selecting Flatten
Image, or use the keyboard shortcut F10. Give
this flattened image a new file name and save
it as a TIFF, JPG or PSD.

It’s faster than it sounds For someone already
familiar with most of Photoshop’s basic com-
mands, this process can go very quickly. For
those readers, this entire article could be writ-
ten with only a couple of paragraphs—mainly
focusing on techniques to mark the size and
location in the secondary background image.
Some might even go an extra step and create
gradient maps on some projects to make let-
tering appear to follow textures in the back-
ground, such as a corrugated panel.

But even without an extensive background
in Photoshop, the steps outlined above should
be easy to follow. Each project is different and
may require a few minor steps and considera-
tions. And remember, if you can sell a job
without having to make a mock-up image,
do it. Save the time and overhead! •SC
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